
!! PNSPO!

!
 
 
 
Lean Automation Kit 

Quick Start Guide – CP1L-E & NB HMI 
 
Introduction: 
 
This document describes the procedure to setup your Lean Automation Kit.  Your kit 
comprises of a CP1L-E Ethernet-equipped PLC, NB-series colour touchscreen HMI 
(Ethernet), Westermo SDI-550 5-port Ethernet switch, and S8VS-06024 24VDC power 
supply.  Optionally, you may have selected a CP1W analogue I/O expansion module and a 
JX or MX2 inverter and/or SmartStep2 servomotor system. 
You will also have been supplied with all necessary cables and communication modules 
for the inverter and/or servo options, a CD containing samples software (for both PLC and 
HMI) and a library of technical manuals. 
 
If you have any questions regarding the assembly or operation of your kit, please call: 
 

Technical Support Team: 0870 752 0871 
or visit www.myOMRON.com 

 
 

Scope of Kits: 
 
Each kit contains an NB-series colour touchscreen HMI which is connected to the CP1L-E 
PLC via the Westermo 5-port Ethernet switch, using the supplied CAT6 patch cable. 
CX-Programmer V8.2 upwards (part of the CX-One V3 or V4 Automation Suite) is required 
to program this PLC, which you may have purchased optionally with your kit. 
NB-Designer (supplied on the resource CD) is used to program the HMI. 
The sample PLC and HMI software applications provided on the resource CD illustrate 
how pre-written Function Blocks (FB) simplify the communication process between the 
PLC and inverter(s), allowing full control and parameterisation whilst eliminating the need 
for traditional digital I/O links between the devices. 
For the SmartStep2 servomotor system option, high-speed pulse I/O control is used for 
speed and position reference, supported by dedicated PLC instructions.  Again, pre-written 
PLC and HMI applications are provided on the resource CD to demonstrate these 
functions. 
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Preparation: 
 
Installing the Analogue I/O Option Module: 
 

1. Remove the blanking cover from the leftmost Option Board position of the CP1L-E 
PLC (Slot 1) and insert the CP1W-ADB21/DAB21V/MAB221 module. 

2. If you have ordered the JX or MX2 inverter option, please insert the CP1W-CIF11 
RS422/485 option module into the rightmost Option Board position (Slot 2).  The 
supplied software application for the JX/MX2 inverter is written assuming that that 
this module will be located in Slot 2* 

 
* Note that CP1L-E20 models only have one expansion slot on the front of the CPU; this is designated as ‘Slot 2’ 

 
Wiring the PLC, HMI and power supply: 
 
The S8VS-06024 power supply included with your kit is capable of supplying 2.5A at 
24VDC, which is intended to supply the required power to the CP1L-E PLC, the NB-series 
HMI, the Westermo 5-port Ethernet switch and all I/O signals to the inverter and 
servomotor systems.  If you are connecting additional devices to the outputs of the PLC 
that require 24VDC, please be aware of the maximum current capability of this power 
supply. 
 

1. Using 0.5mm2 – 2.0mm2 cable, connect a 230VAC mains supply to the S8VS-
06024 in accordance with datasheet T01E-EN-02 (see Resource CD > TECHNICAL 
DOCUMENTATION > S8VS PSU ) 

2. Using 0.5mm2 (20AWG) wire, connect the ‘+V’ output terminal of the S8VS-06024 
power supply to the ‘+’ input terminal of the PLC and the ‘24V’ terminal of the NB-
series HMI 

3. Using 0.5mm2 (20AWG) wire, connect a ‘jumper’ between the ‘+’ terminal of the 
PLC and the ‘COM’ terminal, as show in diagram 1 overleaf. 

4. Using 0.5mm2 (20AWG) wire, connect the ‘-V’ output terminal of the S8VS-06024 
power supply to the ‘-’ input terminal of the PLC and the ‘0V’ terminal of the NB-
series HMI 

5. Using 0.5mm2 (20AWG) wire, connect ‘jumpers’ between the first four ‘COM’ 
terminals of the PLC output terminal block and a longer wire to the ‘-V’ output 
terminal of the S8VS-06024 for NPN configuration (CP1L-M30DT-D model) or to 
the ‘+V’ terminal for PNP configuration (CP1L-M30DT1-D model).  This step is only 
necessary if you have selected the SmartStep2 servomotor option. 

6. Connect the NQ-CN222 cable between the NQ HMI and the PLC, connecting the 
end marked “PT” to the HMI. 

 
Note: If you selected the SmartStep2 servomotor option, you will have been supplied with 
a transistor output PLC, either CP1L-M30DT-D (NPN outputs) or CP1L-M30DT1-D (PNP 
outputs).  Pleas ensure that you follow the correct wiring procedure depending on your 
model; page 18 for PNP or page 20 for NPN.  Although the inputs (to the PLC) may be 
wired for NPN or PNP, the shown configuration provides NPN inputs, which are necessary 
for compatibility with the SmartStep2 output signals.   
If you have not chosen the SmartStep2 option, you can wire the inputs for PNP 
configuration, by connecting the ‘COM’ terminal to the adjacent ‘-‘ (0V) terminal. 
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Wiring the JX inverter option: 
 
The JX-series inverters feature built-in RFI filters, so no additional external filters are 
required. 
Before wiring the JX inverter, please refer to the “Precautions for Safe Use” section (pages 
5-9) of the User’s Manual,ref: I558-E2-02 (see Resource CD > TECHNICAL DOCUMENTATION > JX 
INVERTER) 
It is not necessary to connect a motor to the JX inverter whilst testing ‘on the bench’.  
However, if a motor is connected, please refer to the wiring instructions in section 2-2.  
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Serial communication connection between the JX inverter and PLC: 
 
The JX inverter will be controlled entirely by MODBUS commands over the RS485 serial 
communication link (to the CP1L PLC), so no ‘hard’ I/O wiring is required.  Your Lean 
Automation Kit will have been supplied with a communication cable which fits between the 
RJ45 (‘Ethernet-style’) socket on the front of the JX and the screw terminals of the CP1W-
CIF11 RS422/485 communications option module, fitted in the right-hand slot of the CP1L 
PLC. 
 

 
 

1. Insert the RJ45 connector end into the front of the JX inverter (located behind the 
rubber flap) 

2. Connect the GREEN wire into the first terminal of the CP1W-CIF11 communications 
option module, marked ‘RDA-‘ 

3. Connect the WHITE/BLUE wire into the second terminal of the CP1W-CIF11 
communications option module, marked ‘RDB+ ‘ 

4. Remove the CP1W-CIF11 module from the PLC; set the DIP switches (at the rear 
of the unit) according to the diagram below: 

 

 
Setting the JX communications parameters for MODBUS: 
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By default, the JX is set to accept its speed reference from the front-mounted “volume” 
potentiometer and run command signal from the built-in keypad. 
In order for the JX to be controlled entirely over MODBUS, the parameters and settings 
detailed below must be changed. 
The sample software application included on the resource CD uses MODBUS settings of 
9,600bps (baud rate), 8 data bits, 1 stop bit and no parity, and also assumes that the JX 
has a node number (network address) of 1.  Therefore, a couple of other parameters also 
need to be changed from their defaults. 
 
Please refer to section 3-4 “Operating Procedure” of User’s Manual I558-E2-02 if you are 
unfamiliar with the operation of the front panel keypad. (see Resource CD > TECHNICAL 
DOCUMENTATION > JX INVERTER) 
 
 

1. Change parameter A001 to a value of “03” to enable the setting of the frequency 

reference via MODBUS  

2. Change parameter A002 to a value of “03” to enable the setting of RUN command 

selection via MODBUS  

3. Change parameter C070 to a value of “03” – this defines that the RJ45 port will be 

used for MODBUS communication rather than for the connection of an external 

operator keypad panel 

4. Change parameter C071 to a value of “05” – this changes the communication baud 

rate to 9600 (used in the sample program) from the default of 4800 baud 

5. Turn off the power to the JX inverter (setting procedure continued over page…) 
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6. Loosen the screw in the bottom left corner of the inverter and remove the front 

cover 

7. Turn DIP switch ‘S7’ to the upper ‘485’ position, as indicated in the diagram below 

(leave switch ‘S8’ in its default OFF position) 

8. Replace the front cover and reapply power to the inverter 
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Wiring the MX2 inverter option: 
 
Your MX2 inverters will have been supplied with an appropriate RFI footprint filter, AX-
FIM101-RE. 
Before wiring the MX2 inverter, please refer to the “Precautions for Safe Use” section of 
the User’s Manual, ref: I570-E2-01 (see Resource CD > TECHNICAL DOCUMENTATION > MX2 
INVERTER) 
 
It is not necessary to connect a motor to the MX2 inverter whilst testing ‘on the bench’.  
However, if a motor is connected, please refer to the wiring instructions in section 2-3-12 
and earthing/EMC recommendations in section D-1-2 
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1. Attach the MX2 inverter to the filter using the M4 screws (4 off) supplied with the 
filter. 

 
2. Attach a suitable 230VAC mains supply to the terminal block of the filter, ensuring 

that the earth is securely connected to the stud to the left of the terminal block, 
using a crimp-on eyelet.  For MX2-AB002-E (0.25kW) and MX2-AB004-E (0.4kW) 
models, AWG16/1.3mm2 cable should be used.  For the MX2-AB007-E (0.75kW) 
model, AWG12/3.3mm2 cable should be used. (See section 2-3-6 of User’s Manual 
I570-E2-01 for further details and fuse protection recommendations.) 

 
3. The filter includes captive AC supply cables which should be connected accordingly 

to the L1 (Live) and N (Neutral) screw terminals of the MX2 inverter, as shown in 
the diagram on the previous page.  The Earth wire is terminated into an eyelet 
which should be attached to the leftmost M4 chassis ground screw.  (See section 2-
3-11 of User’s Manual I570-E2-01 for further details.) 

 
4. If used, connect the motor to the MX2 inverter in accordance with the wiring 

instructions in section 2-3-12. 
 

5. Perform the pre-check and power-up tests as detailed in section 2-4. 
 
 
Serial communication connection between the MX2 inverter and PLC: 
 
The MX2 inverter will be controlled entirely by MODBUS commands over the RS485 serial 
communication link (to the CP1L PLC), so no ‘hard’ I/O wiring is required.   
Your Lean Automation Kit will have been supplied with a 2m twisted-pair cable which fits 
between the ‘SN’ and ‘SP’ terminals of the MX2 and the screw terminals of the CP1W-
CIF11 RS422/485 communications option module, fitted in the right-hand slot of the CP1L 
PLC. 
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Up to 31 inverters may be connected to a MODBUS ‘master’ (in this case, the CP1L PLC), 
using unshielded, twisted-pair cable is used to ‘daisy chain’ them together.  Suitable cable 
is Belden 9502 or equivalent. 
 
 

 
 

1. Using the supplied cable, connect the black wire to the first screw terminal of the 
CP1W-CIF11 module (marked RDA-) and the red wire to the second screw terminal 
(marked RDB+). 

 
2. At the MX2 end, connect the black wire to the terminal marked SN and the red wire 

to SP, as shown in the diagram above. 
 

3. Turn the “DIP switch for termination resistor” (marked ‘MD SW1’ - see diagram on 
previous page for location) to the right, to its ON position. 

 
4. Remove the CP1W-CIF11 module from the PLC; set the DIP switches (at the rear 

of the unit) according to the diagram below: 
 
 

 
 
 

 



 

 
OMRON ELECTRONICS LTD ● Technical Support: 0870 752 0871 or visit www.myOMRON.com 

12

 

Setting the MX2 communications parameters for MODBUS: 
 
By default, the MX2 is set to accept speed reference and run command signals from the 
built-in front panel keypad and external digital input signals. 
In order for the MX2 to be controlled entirely over MODBUS, the following parameters 
(A0001 and A0002 in bold, below) must be changed.  Please be sure to reboot the power 
to the inverter after changing these parameters in order for the new settings to take effect. 
The sample software application included on the resource CD uses MODBUS settings of 
9,600bps (baud rate), 8 data bits, 1 stop bit and no parity, and also assumes that the MX2 
has a node number (network address) of 1.  Therefore, no other parameters need to be 
changed from the defaults, as they already match these settings. 
 
Please refer to section 2-5 of User’s Manual I570-E2-01 if you are unfamiliar with the 
operation of the front panel keypad. 
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Using the built-in safety features of the MX2 inverter 
 
The MX2 inverter enables safety compliance to PLd (“Performance Level d”), ISO13849-2 
cat4, SIL3, when used with a suitable safety relay unit such as the Omron G9SA-301. 
 
Ensure that power is removed from the MX2 and remove the front cover.  Just above the 
screw terminal block are three single DIP switches in a horizontal row… 
 

 
 
Turning the middle switch to the ON position sets digital inputs 3 and 4 to be used as 
normally-closed safety inputs.  This action automatically forces drive parameters C003=77 
and C004=78 to define the use of these safety inputs. 
 
Turning the right-most DIP switch to the ON position defines that output terminal 11 is to 
be used as an external safety monitor (EDM) output. 
 
The wiring diagram on the following page assumes that a single 2 x NC (normally closed) 
contact emergency stop switch is to be used with a single MX2 inverter. 
The Omron G9SA-301 safety relay unit is shown wired for manual reset (i.e., the MX2 will 
not be reset until the button is pressed), but it can, of course, be wired to automatically 
reset once the E-stop button is released.  Please refer to G9SA manual ref J121-E2-03A 
for alternative wiring details. 
 
The MX2’s “P24” (24VDC) terminal provides power to the safety relay’s I/O circuit (G9SA 
terminals 13 and 23). 
Please ensure that the metal jumper across the “L” and “PLC” terminals of the MX2 
remains in place (this is its factory default position).  This is the MX2’s internal power 
supply 0VDC connection for I/O connections. 
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As stated on the previous page, MX2 inputs 3 and 4 become dedicated safety inputs once 
the [middle] DIP switch SF SW1 is turned ON. 
 
Similarly, with the [right-most] DIP switch EDM SW1 turned to the ON position, output 11 
becomes a dedicated EDM (External Device Monitor) output for use with the external 
safety monitoring relay. 
 
Operation; 
 
With the E-stop button in its “released” position and the reset switch “open”, the MX2 will 
run as normal. 
As soon as the E-stop button is pressed, the MX2’s power outputs (to the motor) are 
instantly ‘cut’.  Please bear in mind that depending on the application, this may cause the 
motor to coast to a stop.  In some cases, it may be preferable to perform a controlled stop 
of the motor (using the inverter’s DC injection braking) before removing the power. 
The MX2 will display an “E37.□” error code to indicate that a safe stop has occurred. 
 
Once the E-stop is released and the RESET button has been pressed, the MX2 will revert 
to normal operation. 
Please be aware that it could instantly start again if the command inputs and frequency 
reference remain set.
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Wiring the SmartStep2 servo option: 
 
The 100W, 200W and 400W SmartStep2 servomotor system will have been supplied with 
the R7A-FIB104-RE footprint RFI filter.  The R7D-BP0 servomotor amplifier should be 
attached to this filter using the supplied M4 screws.  
 

 
 

1. Connect a 230VAC supply to the filter, as shown in the diagram above, ensuring 
that an earth connection is made to the M4 stud behind the terminal block. 

 
2. Connect the output power connector from the filter into ‘CNA’ of the servo amplifier.  

Attach the flying earth cable eyelet to one of the two earthing screws to the left side 
of this connector. 
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3. Attach the motor encoder cable (R88A-CRGB001-5CR-E) between terminal ‘CN2’ 
of the servo amplifier and the short flying cable at the rear of the servomotor. 

 
4. Attach the motor power cable (R88A-CAB001-5SR-E) between terminal ‘CNB’ of 

the servo amplifier and the short flying cable nearer the shaft end of the servomotor. 
 
 
 
 

 
 

5. Attach the control I/O cable (R7A-CPB001S) into terminal ‘CN1’ of the servo 
amplifier and secure the retaining screws. 
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Connecting the control I/O signals between the SmartStep2 and PLC; 
 
The PLC provides output signals to the SmartStep2 for RUN, RESET, ECRST (deviation 
counter reset), CW (clockwise pulses) and CCW (counter-clockwise pulses). 
The SmartStep2 provides the following signals back to the PLC; /ALM (alarm condition, 
normally closed), INP (positioning completed) and Z (encoder Z phase).  For 100W, 200W 
and 400W SmartStep2 servo amplifiers, these output signals are NPN only.  To 
accommodate this, the PLC inputs are wired accordingly as NPN (sinking), i.e., for the 
inputs, the commons are connected to +24VDC 
The output signals from the PLC to the SmartStep2 are wired as PNP or NPN, depending 
on the CP1L model selected (CP1L-M□□DT-D has NPN outputs, CP1L-M□□DT1-D has 
PNP outputs).  Wiring diagrams for both configurations are shown on the next pages, so 
be sure to follow the correct one for your chosen CP1L. 
 
The CW (clockwise) and CCW (counter-clockwise) signals into the SmartStep2 amplifier 
must be 5V TTL level compatible; as we are working with a 24VDC supply, these levels 
must be ‘dropped’ using 2KΩ resistors, to prevent damage to the input circuitry.  A resistor 
module is included with the kit for this purpose.  Alternatively, you may prefer to solder 
(and heatshrink protect) your own 2KΩ resistors in series with the CW and CCW 
connections. 
 
 
 
 
Please refer to the diagram overleaf for full wiring details… 
 
 

1. Cut-back about 25cm of the outer sheathing and braiding from the R7A-CPB001S 
control I/O cable. 

2. Separate the YELLOW (1 RED BAND) and YELLOW (1 BLACK BAND) wires, twist 
these together and connect them (via a screw-terminal block or solder) to the +24V 
terminal of the S8VS power supply. 

3. Separate the GREY (3 BLACK BANDS), WHITE (3 BLACK BANDS), ORANGE (1 
RED BAND), GREY (2 RED BANDS) and GREY (2 BLACK BANDS) wires, twist 
these together and connect them (via a screw-terminal block or solder) to the 0V 
terminal of the S8VS power supply. 

4. Connect the ORANGE (3 RED BANDS) wire to input 0.06 – this is the ‘Z’ output 
from the servomotor encoder, used to datum the system. 

5. Connect the PINK (1 RED BAND) wire to input 1.04 – this is the ‘ALARM’ signal 
(normally closed) which indicates that the system is in error. 

6. Connect the PINK (1 BLACK BAND) wire to input 1.05 – this is the ‘IN POSITION’ 
signal which indicates that the drive has completed its move successfully. 

7. Cut the GREY (3 RED BANDS) wire and connect to one side of the resistor module.  
Connect the off-cut of this cable to the other side of the resistor module, then to 
output 100.00 – this is the ‘CLOCKWISE PULSES’ command signal. 

8. Cut the WHITE (3 RED BANDS) wire and connect to one side of the resistor 
module.  Connect the off-cut of this cable to the other side of the resistor module, 
then to output 100.01 – this is the ‘COUNTER CLOCKWISE PULSES’ command 
signal. 

PNP VERSION FOR CP1L-M30DT1-D 
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9. Connect the GREY (1 BLACK BAND) wire to output 100.04 – this is the ‘ERROR 
COUNTER RESET’ signal which resets the drive’s internal following error counter in 
the event of a fault caused by this. 

10. Connect the ORANGE (1 BLACK BAND) wire to output 100.06 – this is the ‘RUN’ 
command signal to the drive. 

11. Connect the GREY (1 RED BAND) wire to output 100.07 – this is the ‘RESET’ 
signal to the drive, to be used after an error. 
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SmartStep2 servo amplifier to PLC wiring; 
 
PNP CONFIGURATION FOR CP1L-M30DT1-D MODEL 
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Please refer to the diagram overleaf for full wiring details… 
 
 

1. Cut-back about 25cm of the outer sheathing and braiding from the R7A-CPB001S 
control I/O cable. 

2. Separate the ORANGE (1 RED BAND), WHITE (3 RED BANDS) and GREY (3 
RED BANDS) wires, twist these together and connect them (via a screw-terminal 
block or solder) to the +24V terminal of the S8VS power supply. 

3. Separate the YELLOW (1 RED BAND), YELLOW (1 BLACK BAND), GREY (2 RED 
BANDS) and GREY (2 BLACK BANDS) wires, twist these together and connect 
them (via a screw-terminal block or solder) to the 0V terminal of the S8VS power 
supply. 

4. Connect the ORANGE (3 RED BANDS) wire to input 0.06 – this is the ‘Z’ output 
from the servomotor encoder, used to datum the system. 

5. Connect the PINK (1 RED BAND) wire to input 1.04 – this is the ‘ALARM’ signal 
(normally closed) which indicates that the system is in error. 

6. Connect the PINK (1 BLACK BAND) wire to input 1.05 – this is the ‘IN POSITION’ 
signal which indicates that the drive has completed its move successfully. 

7. Cut the GREY (3 BLACK BANDS) wire and connect to one side of the resistor 
module.  Connect the off-cut of this cable to the other side of the resistor module, 
then to output 100.00 – this is the ‘CLOCKWISE PULSES’ command signal. 

8. Cut the WHITE (3 BLACK BANDS) wire and connect to one side of the resistor 
module.  Connect the off-cut of this cable to the other side of the resistor module, 
then to output 100.01 – this is the ‘COUNTER CLOCKWISE PULSES’ command 
signal. 

9. Connect the GREY (1 BLACK BAND) wire to output 100.04 – this is the ‘ERROR 
COUNTER RESET’ signal which resets the drive’s internal following error counter in 
the event of a fault caused by this. 

10. Connect the ORANGE (1 BLACK BAND) wire to output 100.06 – this is the ‘RUN’ 
command signal to the drive. 

11. Connect the GREY (1 RED BAND) wire to output 100.07 – this is the ‘RESET’ 
signal to the drive, to be used after an error. 

NPN VERSION FOR CP1L-M30DT-D 
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SmartStep2 servo amplifier to PLC wiring; 
 
NPN CONFIGURATION FOR CP1L-M30DT-D MODEL 
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SmartStep2 servo amplifier to PLC wiring; 
 
PNP CONFIGURATION FOR CP1L-EM30DT1-D MODEL 
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 “CX-One” software installation; 
 

 
 
Omron’s CX-One is a suite of software for programming Omron PLCs, HMIs, ac drives, 
servo and motion control systems and many other components. 
It also features a fully-integrated simulation tool, CX-Simulator, allowing you to create and 
test your PLC and HMI software “off line” without the need for the physical hardware. 
 
CX-One V4.x (optionally supplied with your Lean Automation Kit) can be installed on any 
32-bit or 64-bit Windows© XP, Vista or 7 operating system. 
After inserting the DVD Please follow the on-screen instructions, ensuring that you select 
the “Complete” installation option and use the 16-digit license code which came with your 
package. 
Once installation has completed, you will be asked if you wish to register the product on-
line. 
 

 
 
It is certainly worth doing this immediately, as you won’t be able to access the free on-line 
updates without it, which are added on a regular basis to improve the functionality of the 
software and include support for new hardware models. 
 
Full details regarding the installation and operation of CX-One can be found in the “CX-
One Introduction Guide”, included on the resource CD supplied with the kit. (see Chapter 1 
– Overview and Installation of CX-One) (see Resource CD > TECHNICAL DOCUMENTATION > CX-ONE) 
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“NQ-Designer” HMI software installation; 
 

 
 
NQ-Designer software is not included within the CX-One software suite installation, but is 
included on the Resource CD from the Lean Automation Kit (see Resource CD > SOFTWARE > 

NQ-DESIGNER), or can be freely downloaded via www.myOMRON.com  You will need to 
create a simple user account, requiring just an e–mail address and a password, then go to 
Downloads > 4.Products > Software > NQ Designer, where you will find the latest version. 
 
If you download the latest version from www.myOMRON.com, you will need to ‘unzip’ the 
compressed download file. 
 
Run the “setup.exe” file and follow the instructions to install NQ-Designer 
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Downloading the demonstration software; 
 
CP1L PLC program… 
 
Open CX-Programmer from Start > Programs > OMRON > CX-One > CX-
Programmer… 
 

 
 
Launch the application, then select File > Open 
Browse to the SOFTWARE folder on the Resource CD > CP1L PLC DEMO > 
LeanKitDemoCP1L sub-folder and select the LeanKitDemoSoftware.cxp file and click 
Open… 
 

 
 
Connect the USB programming cable (CP1W-CN221) between your PC’s USB port and 
the CP1L PLC ‘Peripheral’ (USB) port, located behind the flap on the left-hand side. 
If this is the first time you have connected to a PLC, you will see this screen… 
 

 
Select the default option, “Install the software automatically (Recommended)” and click 
Next… 
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Windows will then install the USB driver for the PLC… 
  

 
 
If you see the screen below (which depends upon your version of Windows), click 
Continue Anyway… 
 

 
 
Click Finish to complete the installation… 
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From the left-hand window, click LeanCP1L[CP1L] Offline to highlight it (as shown  
below). 
Having done this, you will notice that the small yellow triangle symbol on the top icon bar 
turns from grey to yellow (as shown circled in red below).  This is the Work Online 
shortcut (also available from the PLC menu). 
 

 
 
Clicking on this connects CX-Programmer to the PLC…  
 

 
 
Click Yes to connect. 
 
From the top-level PLC menu, select Transfer > To PLC.  Ensure that all boxes are 
‘checked’ (as shown below), then click OK…  
 

 
 
You will be asked if you wish to continue; click Yes… 
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Click Yes again… 
 

 
 
It will take no more than about 5 seconds to download the entire PLC application.  Upon 
completion, click OK… 
 

 
 
If you see this message below, click Yes to return the PLC to Monitormode (Run). 
If this is the first time you have used this PLC, at this point you will have to remove the 
power to it, then re-power.  With either of the above, the PLC’s POWER and RUN LED 
indicators should both be lit green. 
 

 
 
 
Now follow the next steps to download the application to the NQ3 HMI… 
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NQ3 HMI application… 
 
Open NQ-Designer from Start > Programs > OMRON > NQ-Designer… 
 

 
  
Launch the application, then select Project > Open 
Browse to the SOFTWARE folder on the Resource CD > NQ3 HMI DEMO > 
LeanKitDemoNQ3 sub-folder and select the LeanKitDemoHMI.nqp file and click Open… 
 

 
 
Plug the USB cable (CP1W-CN221) between your PC’s USB port and the NQ3 HMI’s 
“SLAVE” port at the rear of the unit. 
If this is the first time you have connected an NQ HMI, Windows will display “Found New 
Hardware: HMI USB Device” 
Select the “Install from a specific location” option, then browse to C:\Program 
Files\OMRON\NQ-Designer\USBDrivers\ then click “Next” to install the driver.  If the 
Hardware Installation dialog is displayed, click Continue Anyway to complete the 
installation. 
Further details can be found on page 20 of the “V07-EN-01 NQ Getting Started Guide” (see 
Resource CD > TECHNICAL DOCUMENTATION > NQ-SERIES HMI) 
 

 
 
From the Project menu, select Transfer then Download… 
 



 

 
OMRON ELECTRONICS LTD ● Technical Support: 0870 752 0871 or visit www.myOMRON.com 

30

 

 
 
From the left-hand side of the dialog box (“Mode”), select USB and check the Application, 
Font and Firmware boxes, as shown above. 
Now click the Download button. 
The RUN indicator light on the front of the NQ3 will flash blue to indicate that it is receiving 
the project, and messages will be displayed to indicate the progress of the download. 
 

 
 
When the bargraph reaches 100% and “Download Completed” is displayed (as per the 
picture above), click Close.  
 
At this point, the NQ3 HMI will reboot and, providing that the PLC software was 
downloaded beforehand, will display the Lean Automation welcome screen, as shown at 
the start of the next section. 
As a double-check, the orange LED on the PLC’s RS232 option module (CP1W-CIF01), 
should be flashing very rapidly, almost appearing to be permanently lit; this indicates that 
communication is taking place between the HMI and PLC. 
 
You are now ready to run the demonstration software!
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Using the demonstration software; 
 
The demonstration programs for the PLC and HMI are ‘universal’ and have been written 
for any combination of the Lean Automation Kit. 
 
On power-up, you will see the welcome screen below.  The HMI’s system ‘beeper’ can be 
disabled by pressing the speaker symbol in the bottom left corner. 
Press “START”… 
 

 
 
 
You will need to define your choice of connected hardware; this enables/disables parts of 
the PLC program.  Just touch the thumbnail picture of the products you have, and a ‘tick’ 
will appear to confirm its selection.  These choices are retained within the PLC, so do not 
need to be re-selected every time you re-power the system. 
 

 
 



 

 
OMRON ELECTRONICS LTD ● Technical Support: 0870 752 0871 or visit www.myOMRON.com 

32

 

Pressing the top-right ‘next’ arrow takes you to the screen shown below.  From here you 
will be able to select control and monitoring of the inverter or servo drive. 
 

 
 
If you selected the “JX/MX2 INVERTER” option, you will see the screen below.  A single 
“Inverter Refresh” function block within the PLC program controls up to 31 drives, which 
can be a mixture of JX and MX2 models. 
Touching the “Enter Frequency” display box brings up a numeric keypad, allowing you to 
enter a speed reference for the inverter.  Note that this value is entered without a decimal 
point, e.g. if you enter “1234”, a value of 12.34Hz will be the speed reference.  By default, 
the JX/MX2 has a maximum frequency reference value of 50.00Hz.  Although a maximum 
value of 400.00Hz is possible (via settings in the drive), the HMI limits the input value to 
50.00Hz. 
“START FWD” and “START REV” will cause the motor to accelerate to the input frequency 
in a clockwise or counter-clockwise direction.  The acceleration and deceleration rates are 
set to the inverter defaults, being 10s.  Note that this figure is to reach the maximum 
frequency (50.00Hz), so if, for example, you set a frequency of 25.00Hz, it would take the 
motor 5s to reach this figure from standstill.  If the drive goes into error for any reason (this 
would generally only happen if a motor was connected, due to mechanical overload 
problems), the inverter can be reset from the HMI by pressing the “ERROR RESET” button, 
once the cause of the fault has been identified and rectified. 
 

 
 
Pressing the top-right “next” arrow takes you on to the inverter monitoring screen… 
The advantage of controlling drives by communications over a network is that all the status 
information for each unit can be monitored. 
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Note that “AT ZERO SPEED” and “UNDER-VOLTAGE DETECT” are only available for the 
MX2 model. 
 

 
 
Pressing the blue “info” symbol on the main control screen brings up the following screen; 
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SmartStep2 servo menu; 
 
If you have a SmartStep2 servo as part of your system, you will be able to control it using 
high-speed digital pulses from the PLC. 
Pressing the “SMARTSTEP2 SERVO” button from the “MAIN MENU” screen brings up the 
following sub-menu for servo control; 
 
 

 
 
The blue “info” button brings up the following three screens which explain the operation 
symbols panel which appears on each of the servo control screens… 
 

 
 

 
 



 

 
OMRON ELECTRONICS LTD ● Technical Support: 0870 752 0871 or visit www.myOMRON.com 

35

 

 
 
 

 
 
Performing a servo Origin Search; 
 
Firstly, from this screen, the servo must be “Enabled”; pressing this button will turn it green 
to indicate that the servo system is enabled and ready to go.  If you try to turn the servo 
motor shaft by hand, you will notice that it is ‘locked’ into position.  If you have not changed 
any parameters on the SmartStep2 servo amplifier, you will probably notice that it is 
possible to turn the motor shaft slightly from side to side, but it will always ‘spring back’ to 
its default position.  In reality, the servo system will be ‘tuned’ to the application (by using 
the ‘Auto Tune’ facility within ‘CX-Drive’ software), to increase the ‘rigidity’. 
 
In order to use ‘absolute’ positioning, and origin search must be performed to give the 
motor a ‘home’ reference point.  There are many different ways in which an origin search 
can be performed (usually involving an external home position sensor such as a proximity 
switch), but in this case we have just used the “Z” phase of the servo motor’s encoder, 
which is a single pulse marker for each complete revolution of the shaft.  Pressing the 
“ORIGIN SEARCH” button will cause the motor to rotate no more than one revolution until 
the PLC ‘sees’ the Z-phase marker.  Once completed, the “AT ORG” indicator on the HMI 
screen will light green to indicate that the system has successfully performed an origin 
search. 
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Manual Jogging; 
 
A manual jog function is provided to rotate the motor at low speed either clockwise or 
counter-clockwise.  Touching the “Enter Jog Speed” display causes the keypad to pop up.  
500Hz is a good starting point, rotating the motor shaft at one-quarter of a turn per second.  
Press the “JOG CW” or “JOG CCW” button to turn the motor; the motor will continue to 
rotate in the chosen direction for as long as you keep your finger on the button.  The 
“PULSING” indicator will light green to indicate that the PLC is outputting pulses and the 
“IN POSN” indicator will extinguish to indicate that the motor is moving.  “IN POSN” will re-
light when you remove your finger from the button; this indicates that the motor has moved 
the requisite number of pulses commanded by the PLC.  If this indicator were not to re-
light, it would generally mean that the motor was not able to move in accordance with the 
pulses sent from the PLC because of a mechanical problem or the motor becoming 
disconnected from the servo amplifier. 
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Relative Position Control; 
 
The motor can be moved a set distance, at a set speed, relative to its current position, 
either clockwise or counter-clockwise. 
By default, 2,500 pulses (set on PLC power-up) will rotate the motor exactly one revolution.  
At the default speed of 5,000Hz, a single revolution will be completed on 0.5s 
The relative position value can be set between 0 – 100,000 pulses (40 revolutions) 
The pulse output speed can be set between 0 – 100,000Hz (40 revs/sec) 
 
The “PULSING” indicator will light green to indicate that the PLC is outputting the 
requested number of pulses and the “IN POSN” indicator will extinguish to indicate that the 
motor is moving.  “IN POSN” will re-light when the movement profile has been completed. 
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Absolute Position Control; 
 
NOTE: absolute positioning can only be performed if an Origin Search has been 
performed.  If the “NO ORG” indicator is lit red, this means that the servo has no 
origin reference position and absolute position movements will not be possible. 
Please return to the SmartStep2 Menu and select “ORIGIN SEARCH” before 
proceeding. 
 
The motor can be moved a set distance, at a set speed, relative to its origin position, either 
clockwise or counter-clockwise. 
By default, the Absolute Position value is set to 0.  If you have been jogging the motor or 
performing relative movements, the motor will rotate back to its origin position when you 
press the “GO TO POSITION” button.  For instance, if, after performing an Origin Search 
and using relative positioning, you rotated the motor 20 turns clockwise, 4 turns counter-
clockwise, then jogged it a quarter turn counter-clockwise, performing an Absolute Position 
movement to 0 would cause the motor to rotate 15.75 revolutions counter-clockwise to its 
home (origin) position. 
 
As with relative positioning, the power-on default speed is of 5,000Hz, so a single 
revolution will be completed on 0.5s 
The absolute position reference can be set between 0 – 100,000 pulses (40 revolutions); 
this is only limited by the data entry keypad on the HMI.  The actual maximum value can 
be 2,147,483,647 pulses (approx. 859,000 revolutions) 
The pulse output speed can be set between 0 – 100,000Hz (40 revs/sec); this maximum 
value is a restriction of the capability of the CP1L PLC. 
 
 

 
 
The “PULSING” indicator will light green to indicate that the PLC is outputting the 
requested number of pulses and the “IN POSN” indicator will extinguish to indicate that the 
motor is moving.  “IN POSN” will re-light when the movement profile has been completed. 
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Lean Kit Resource CD; 
 
The CD supplied with the Lean Kit contains the demonstration software for PLC and HMI, 
a copy of NQ-Designer programming software, brochures and datasheets, and technical 
documentation (User Manuals, Programming Manuals, etc) for all products; 
 

 
 
 
Additional information can be found at www.industrial.omron.co.uk 
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JX-MX2 INVERTER REFRESH FUNCTION BLOCK
PNSPO

An introduction to the 
JX/MX2 Inverter Refresh 

Function Block -
Controlling up to 31 

Inverters using MODBUS 
communication

over 2-wire RS485
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JX-MX2 INVERTER REFRESH FUNCTION BLOCK
PNSPO

Controls and monitors up to 31 JX 
and MX2 inverters (in any 
combination) via a 2-wire RS485 
network. 
No additional programming 
required, other than defining 
which ‘nodes’ are present and 
which type of inverter (JX or 
MX2) is used at each ‘node’.

 

JX-MX2 INVERTER REFRESH FUNCTION BLOCK
PNSPO

#CCCC means that we’re using 
this Function Block with a CP-
series PLC and &2 means that the 
CP1W-CIF11 RS422/485 module 
is located in Port 2

 



 

 
OMRON ELECTRONICS LTD ● Technical Support: 0870 752 0871 or visit www.myOMRON.com 

42

 

 

01

JX-MX2 INVERTER REFRESH FUNCTION BLOCK
PNSPO

‘InverterScanlist’ defines which 
‘nodes’ are present on the 
network. We have used 
D1002/1003 = 32 bits
If bit 01 of word D1002 is set to 
ON and all others OFF, this would 
mean that we have only one 
inverter present as Node #01
This could be done as a series of 
touchswitches on an HMI…

0002030406 05070809101112131415000102030406 05070809101112131415

D1002D1003

15 14 13 12 11 10 09 08 07 06 05 04 03 02 0130 29 28 27 26 25 24 23 22 21 20 19 18 17 1631
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1

JX-MX2 INVERTER REFRESH FUNCTION BLOCK
PNSPO

‘InverterType’ defines whether JX 
or MX2s are used. We have used 
D1000/1001 = 32 bits
If bit 01 of word D1000 is set to 
ON, this would mean that we 
have an MX2 present as Node 
#01
If it is OFF, this means it’s a JX
These are only effective if the 
node is defined as being ‘present’
in the previous setting.

00000 0000000000000000 0000000000

D1000D1001

15 14 13 12 11 10 09 08 07 06 05 04 03 02 0130 29 28 27 26 25 24 23 22 21 20 19 18 17 1631
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JX-MX2 INVERTER REFRESH FUNCTION BLOCK
PNSPO

The ‘AreaID’ and ‘AreaNo’ define 
which registers will be used to 
hold the command and status 
data for each drive (the “I/F or 
“Interface” area).
In our program, #82 means “use 
DM area” and &100 means “start 
at DM100”. 

 

JX-MX2 INVERTER REFRESH FUNCTION BLOCK
PNSPO

DM100
DM101
DM102
DM103
DM104
DM105
DM106
DM107
DM108
DM109
DM110
DM111

DM162
DM163

DM100.00
DM100.01
DM100.02
DM100.03
DM100.04
DM100.05

DM100.08
DM100.09

DM100.10

DM100.13

DM100.14
DM100.15

for Node #01

DM101 = Freq Ref for Node #01
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CONTROLLING SMARTSTEP2 WITH CP1 PLC
PNSPO

Using just three instructions 
for complete control of the 

SMARTSTEP2 servo
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PERFORMING AN ORIGIN SEARCH
PNSPO

In order for a servo to perform 
“Absolute positioning”, it requires a 
‘home’ reference point, so that all 
movements can be made with respect 
to this reference position.

There are many different ways 
in which this can be done, 
usually involving the servo 
motor’s encoder ‘Z’ pulse and a 
physical limit or proxi switch on 
the mechanical system.
The method of origin search is 
simply defined within the PLC’s
settings…

 

JOGGING THE SMARTSTEP2
PNSPO

The ‘SPED’ instruction sends 
continuous pulses from an output 
at a fixed speed (generally set 
quite low!)
It will keep doing this until an 
‘INI’ instruction is executed, 
which kills the output.
In this example, bit 220.00 is a 
touchswitch on the NQ3 HMI, and 
the pulses are output as long as 
you keep your finger on the 
button. When you release it, the 
‘INI’ instruction is executed, 
stopping the pulses.
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SMARTSTEP2 – RELATIVE POSITIONING WITH ‘PLS2’
PNSPO

The ‘PLS2’ instruction sends a 
number of pulses from a 
transistor output at a set 
frequency.
This instruction also defines the 
accel and decel rates of the 
movement profile.

The ‘specified number of 
pulses’ (which equates 
to a physical movement 
distance) and ‘target 
frequency’ are input 
from the HMI
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SMARTSTEP2 – RELATIVE POSITIONING WITH ‘PLS2’
PNSPO

‘Relative’ means that the motor 
will move the specified distance, 
clockwise or counter-clockwise, 
with respect to its current 
position.
Positive over-travel (POT) and 
negative over-travel (NOT) inputs 
(from switches/sensors at the 
physical motion limits of the 
mechanical system and wired to 
dedicated inputs of the 
SMARTSTEP2 amplifier) will 
prevent damage to the system if 
you send too many pulses.
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SMARTSTEP2 – ABSOLUTE POSITIONING WITH ‘PLS2’
PNSPO

‘Absolute’ means that the motor 
will move the specified distance, 
clockwise or counter-clockwise, 
with respect to its origin position 
(as a number of pulses from the 
origin).
If no ‘ORG’ has been performed,  
or the power to the system has 
been interrupted since the last 
‘ORG’, absolute positioning cannot 
be performed.
The use of the instruction is 
identical to relative positioning, 
apart from the setting of one ‘bit’.

 

 


